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Introduction 

AutoCAD users are always looking for ways to be more productive. 
That’s why they love tips! I’ve been writing tips for years, so I 

thought I would compile some favorites – both mine and those of my 

readers – so everyone can easily use them! Everyone uses AutoCAD 
differently, but I strived to find tips that will be valuable to a large 

segment of users. 
 

One reason that I love writing AutoCAD tips is that people are so 
appreciative. They really want to learn more about this huge program. 

AutoCAD is not only useful – it’s fun! I hope that this ebook will help 
you become more productive, less stressed, and more knowledgeable.   
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Chapter 1: Working with commands 
AutoCAD is very command driven, so a couple of tips to make working 

with commands faster will increase your productivity. 

1. Ending the LINE command quickly 

Prior to AutoCAD 2000 you could end the LINE command by right-
clicking with your mouse. That was because the right mouse button 
was programmed to be equivalent to pressing Enter. However, 

starting in AutoCAD 2000, right-clicking opens up a shortcut menu. 
One of the options on that menu is Enter which you can click to end 

the LINE command, but who wants to take that extra step? You use 
the LINE command so often, at least it should be easy.  

Here are three very different approaches to solving this annoyance: 

1. De-activate the shortcut menus. Start the OPTIONS 

command and choose the User Preferences tab. Then click 
Right-click Customization. You can then make several choices 
from the dialog box. One option is to use the following settings: 

Default Mode-Repeat Last Command. Edit Mode-Shortcut Menu. 
Command Mode-Enter. However, this approach gets rid of all 

your shortcut menus except when you are editing a selected 
object. I still like to use the shortcut menus for choosing 
command options. So you may want to try one of the other 

approaches. Another options is to check the Turn On Time-
Sensitive Right-Click check box. This makes a quick right-click 

equivalent to pressing Enter, and a longer right-click displays 
the shortcut menu. Then keep the other defaults. 

2. Create a one line ribbon button. Many of the lines you draw 

are drawn one line at a time. You can create a ribbon button 
that automatically ends the LINE command after you draw one 
line. The menu item will read: ^C^C_line;\\; For more 

information on creating a custom ribbon button, see “Tutorial: 
Add a button to the ribbon in AutoCAD.“  I love this option; 

if you create this button, I predict that you’ll use it a lot. 

3. Use your thumb! Is your mouse several inches away from 
your keyboard? Or even at a different height? If you can place it 

next to the keyboard, you can just reach over with your thumb 
and press Enter on the numeric pad to end the LINE 

http://www.ellenfinkelstein.com/acadblog/tutorial-add-a-button-to-the-ribbon-in-autocad-2009/
http://www.ellenfinkelstein.com/acadblog/tutorial-add-a-button-to-the-ribbon-in-autocad-2009/
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command. Or you can use your left hand to hit the spacebar. 
Your left hand is free and the spacebar is big!  

4. Customize your mouse buttons. If you have a three-button 

mouse, you can customize its buttons. Then you can use the 
third button as an Enter button.  

2. Repeat previous commands 

You certainly know that you can repeat the last command by pressing 
Enter or the spacebar. However, many people don’t know that you 

can use the Up arrow to scroll through your previous commands in 
backwards order. 

For example, suppose that you use the following commands: 

LINE 

ARC 

CIRCLE 

Then you can do the following: 

 Press the Up arrow once to display the CIRCLE command on 
the command line and in the Dynamic Input tooltip. 

 Press the UP arrow twice to display the ARC command on the 
command line and in the Dynamic Input tooltip. 

 Press the UP arrow three times display the LINE command on 

the command line and in the Dynamic Input tooltip. 

When you see the command that you want to use, just press Enter to 
execute it. 
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Chapter 2: Specifying Coordinates Fast 

3. Temporarily override object snap settings 

Object snap settings let you quickly choose geometric points on an 

object. For example, you can set up a running (ongoing) Endpoint 
object snap (osnap, for short), so that whenever you get near the 

endpoint of an object, you can snap to it. 

But sometimes, object snaps get in the way, especially if you want to 
specify a point near, but not on, an object snap. Temporary overrides 

are very helpful, because you can turn off the running osnap just for a 
second, while you finish your task. 

Temporary overrides require you to press and hold a key, or key 

combination. As long as you hold down the keys, the override works. 
As soon as you release the keys, your running osnaps are back again. 

Here are the temporary overrides: 

 Toggle object snap mode: Shift+A or Shift+ ‘ (apostrophe) 

 Turn on object snap mode: Shift+S or Shift+; (semicolon) 

 Turn off object snap & object tracking: Shift+D or Shift+L 

 Endpoint osnap: Shift+E or Shift+P 

 Midpoint osnap: Shift+V or Shift+M 

 Center osnap: Shift+C or Shift+ , (comma) 

 Toggle ortho mode: Shift 

 Toggle polar mode: Shift+X or Shift+ . (period) 

 Toggle object snap tracking mode: Shift+Q or Shift+ ] 
(close square bracket) 

Note that each override has a left-handed and a right-handed option. 

If you use your right hand for the mouse (as I do, even though I’m 
left-handed), use the first option. 

Print these out and attach them to the wall or a nearby bulletin board! 
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4. Find elusive coordinates and avoid temporary 
construction lines 

Some coordinates are easy to find. For example, to find the endpoint 
of a line, you just use the Endpoint object snap. 

But others are more elusive. 

For example, recently someone asked me, “I would like to ask if there 

is a simple way to select a center of a rectangle.” 

My answer was: If you press Shift and right-click, you’ll get the 
OSNAP menu. Choose Mid Between 2 Points, and choose two diagonal 

corners. 

Finding coordinates is a very common task, so here are some other 
tips for specifying hard-to-find coordinates. 

Polar coordinates 

To find a point at a specific angle, use polar coordinates, in the format 
distance<angle. So, to draw a line that is 3.5 units at a 15°, enter 
3.5<15. 

Apparent Intersection OSNAP 

The Apparent Intersection object finds an intersection that would be 
created if you extended two objects until they met. It’s very simple to 

use. You start a command, such as the LINE command, specify the 
OSNAP (you can type app), specify a first point, such as an Endpoint, 
then hover over the second point. You’ll see an X at the apparent 

intersection. Just click to lock in the coordinates. 

Extension OSNAP 

The Extension object extends lines and arcs in the same direction, 
past their endpoints. Look for the Extension tooltip; at the same time 

you’ll see a temporary extension path. 

Object snap tracking 

Object snap tracking lets you specify a point based on object snaps of 

existing objects. When you’re looking for the intersection of two 
existing endpoints, it works similarly to the Apparent Intersection 
OSNAP. But it has more uses that that. For example: 
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 You want the endpoint of a line you’re drawing to be vertical to 
the endpoint of an existing line. 

 You want to center a circle inside a rectangle 

 You want to start a line where two existing lines would intersect 
if they extended (you can do this with the Apparent 
Intersection object snap, too) 

Note that you can use object snap tracking with polar snapping, so 
the angles don’t have to be orthogonal. 

Follow these steps: 

1. Turn on at least one running object snap. To do so, right-click 

the Object Snap (OSNAP) button on the status bar and choose 
an object snap, or choose Settings first (depending on your 
version). 

2. Click the Object Snap Tracking button on the status bar (which 
is different from the Object Snap button) to turn on this feature. 

3. Start a drawing command that requires you to specify a point. 

4. Hover the cursor over an object snap, to acquire that point. You 

see a small plus sign at the object snap point. 

5. If necessary, acquire a second point. 

6. Move the cursor toward the coordinate you want to locate until 
you see one or two temporary, dotted alignment paths. You’ll 

also see one or two tooltips and an X. 

7. Click to specify the point. Then continue the command you 
started. 

Here, I started the CIRCLE command and acquired the midpoints of 
the two sides of the rectangle to find its center. This specifies the 
center of the circle at the center of the rectangle 
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Here’s the result: 

 

Temporary tracking 

You can also use temporary tracking to accomplish the same result, 
as long as the angles are orthogonal. Follow these steps: 

1. Turn on at least one running object snap. To do so, right-click 

the Object Snap(OSNAP) button on the status bar and choose an 
object snap, or choose Settings first (depending on your 

version). 

2. Start a drawing command that requires you to specify a point 

3. Type tk and press Enter. 

4. At the First Tracking point: prompt, specify an object snap by 
clicking it. It must be horizontal or vertical to the final point that 

you want to specify. 
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5. Move the cursor horizontally or vertically toward the desired 
coordinate. You see a solid, temporary rubber-band line. 

6. At the Next point: prompt, move the cursor from the rubber-

band line to the second object snap, and click. 

7. Press Enter to end tracking and continue the command. 

Point filters 

Point filters are the original way to specify coordinates that aren’t on 

an object, based on object snaps of existing objects. Most people use 
object snap tracking now, but they can still be useful, especially in 3D 
work. You build an X,Y (or X,Y,Z) coordinate by using the X 

coordinate of one object snap, the Y of another, and perhaps a Z of 
another. 

Follow these steps: 

1. Start a drawing command that requires you to specify a point. 

2. Type .x or .y and press Enter. (You can also Shift + right-click 
to choose a point filter from the object snap menu.) Let’s say I 

start by typing .x. 

3. At the of (need YZ): prompt, use an object snap to specify the 
x coordinate of the desired coordinate. To continue the example 

of drawing a circle centered inside a rectangle, you would 
specify the midpoint one of the rectangle’s horizontal lines, 
because the x coordinate of the circle’s center should be the 

same as the x coordinate of the horizontal line’s midpoint. 

4. Now, simply specify the object snap on an object to locate the y 
coordinate. In this example, specify the midpoint of one of the 

rectangle’s vertical lines. 

5. AutoCAD locates the coordinate and you can continue the 
command. 

From 

From is a feature that lets you find coordinates off objects by 
specifying the offset from an object snap. You can specify that offset 
as the x,y distance or polar coordinate notation. 

Follow these steps: 
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1. Type from and press Enter. (You can also Shift + right-click and 
click From on the object snap menu.) 

2. At the Base point: prompt, specify the base point with an 

object snap. 

3. At the Offset: prompt, enter @ and relative x,y or polar 
coordinates. Note: You must use @ even if you are using a 

default of relative coordinates. 

4. Continue the command. 
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Chapter 3: Selecting and Displaying Objects Quickly 

When you need to edit existing objects, you usually need to select 

them. Here are some tips for selecting and displaying objects quickly. 

5. Use Quick Select to select objects in AutoCAD 

The Quick Select dialog box is a simple filtering device that helps you 
select the objects you want. For more advanced filters and for when 
you want to save filters, use the FILTER command. 

There are 4 ways to open Quick Select in AutoCAD: 

 Home tab> Utilities panel>Quick Select 

 With no command active, right-click in the drawing area and 
choose Quick Select 

 Click the Quick Select button in the Properties palette 

 Type qselect on the command line. 

Here’s a simple drawing with some lines and blocks. 

 

Here’s the Quick Select dialog box. You use it by working your way 

from the top down. 
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Watch a video to see several examples of using the Quick Select 
feature. 

6. Select objects with a polygon selection window 

You can create an irregularly-shaped polygon selection window at 
almost any prompt? Don’t see that option on your command line? 

That’s because it isn’t there, but it is available. 

All you need to do is start your command, and before you pick the 
first point in the drawing type either ‘CP’ or ‘WP’ and press ENTER. 

Pick as many points as you would like to create your selection 
window, then right click. 

The ‘CP’ stands for ‘Crossing Polygon’ and anything touched by the 

polygon window will be selected. The ‘WP’ stands for “Window 
Polygon” and only the objects that are fully inside the polygon will be 
selected. 

https://s3.amazonaws.com/ellenfinkelstein.com/website+video+tutorials/quick_select_controller.swf
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7. Easily hide and isolate objects 

Starting in AutoCAD 2011, there are three commands that help you 

hide selected objects or isolate them (hide everything except the 
selected objects). 

 The ISOLATEOBJECTS command hides all objects except those 
that you select. After selecting objects, right-click in the 

drawing area and choose Isolate> Isolate Objects. 

 The HIDEOBJECTS command hides selected objects. Select the 
objects, right-click in the drawing area, and choose Isolate> 

Hide Objects. 

 The UNISOLATEOBJECTS command undoes either of the 
previous commands, displaying objects that those commands 

hid. 

For several releases, there has been a command to isolate objects by 
layer, the LAYISO command. By default, LAYISO locks and fades the 

other layers (objects not on the same layer as the object you 
selected). You can use the Settings option to turn those layers off 

instead. 

The LAYUNISO command reverses the effect of the LAYISO command. 

8. Tips on viewing your drawing 

The faster you can display the section of your drawing where you 

need to work, the faster you can get started drawing and editing. 
With that in mind, here are some tips for viewing your drawing: 

Use the mouse wheel 

The mouse wheel is the key to fast view changes: 

 You can zoom in and out by rolling your mouse wheel. Roll 
away from you to zoom in, towards you to zoom out. Did you 

know that where you place the cursor determines the center of 
the zoom? You don’t have to click. Just move the cursor to the 
area of your drawing that you want to zoom in to, and zoom in 

with the mouse wheel. 

 You can do a Zoom Extents by double-clicking the mouse 
wheel. 
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 You can pan by dragging (pressing and holding) with the mouse 
wheel. Tip: You can pan past the application window and even 

the edge of your screen. Just keep dragging the mouse cursor. 

 In 3D drawings, press Shift + the mouse wheel and drag to do 
a transparent 3D orbit. 

Save a view 

Saving views is especially helpful in large drawings. Set up the view 
that you want and then use the VIEW command to open the View 
Manager. Click New and enter a name. Click OK to accept the default 

of using the current view. Or choose Define Window to return to your 
drawing to define a view boundary. You can pan and zoom at the 

same time. Press Enter to return to the View Manager. Click OK to 
complete the process. 

To display a saved view, you can again use the VIEW command. 

Choose the view from the list, click Set Current, and click OK. But it’s 
probably easier to go to the View tab; there you can find your saved 
views in the Views panel. 

You can open a drawing to a saved view. In the Select File dialog box, 

check the Select Initial View check box and click Open. The Select 
Initial View dialog box opens, where you can choose the view that you 

want to display when you open the drawing. Click OK. 
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Use the ViewCube 

For 3D drawings, the ViewCube is a handy 
way to change viewpoints. You just click on 

the face, edge or corner of the cube. You 
can also drag the ViewCube to make minor 

changes in your viewport; when you use it 
that way, it’s not that different from 3D 
Orbit.  
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Chapter 4: Editing Objects Precisely 

9. Rotate one object to match another 

Sometimes you need to rotate an object to match the angle of an 

existing object. Here’s one way to accomplish that, using the 
Reference option of the ROTATE command. 

In this example, you want to rotate the desk to match the rotation of 

the end wall. Follow these steps: 

  
 

 
 Start the ROTATE command and select the objects that you 

want to rotate. 

 At the Specify base point: prompt, specify the base point of 
the object you want to reference to, not the base point of the 

object you want to rotate. This is point 1 in the above figure. 
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 At the Specify rotation angle or [Reference]: prompt, 
choose the Reference option. 

 At the Specify the reference angle <0>: prompt, pick the 

point on the object that you want to rotate that corresponds to 
the base point you just specified. This is point 2 in the figure. 

 At the Specify second point: prompt, pick the second point 

that, together with the previous point, specifies the angle of the 
object that you want to rotate. This is point 3 in the figure. 

Notice the rubber band line from your base point (point 
1)connecting to your object as you move the cursor, as shown 
below: 

 
 

 
 At the Specify the new angle: prompt, pick the point on the 

reference object that, together with its base point, specifies the 
angle of the reference object. This is point 4 in the first figure. 

The selected object rotates to match the angle of your reference 
object, as you see here. Then move the object to its proper location. 
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Here’s another way to use the Reference option of the ROTATE 

command and end up with the same result. Follow these steps: 

1. Start the ROTATE command and select the objects that you 
want to rotate. 

2. At the Specify base point: prompt, specify the base point of 

the object that you want to rotate. In the top image, that would 
be point 2. 

3. At the Specify rotation angle or [Reference]: prompt, 

choose the Reference option. 

4. At the Specify the reference angle <0>: prompt, pick the 
point on the object that you want to rotate that corresponds to 

the base point you just specified. This is point 2 in the figure. 
So you’re picking point 2 again. 

5. At the Specify second point: prompt, pick the second point 

that, together with the previous point, specifies the angle of the 
object that you want to rotate. This is point 3 in the figure. 

6. At the Specify the new angle: prompt, choose the Parallel 

object snap. (Shift + right-click and choose Parallel) This 
OSNAP works in an interesting way, something like acquiring a 

tracking point. Move the cursor over the line you want to align 
to, in this case the line from points 1 to 4. Then move the 
cursor around to rotate the desk until you see a dotted 

extension line. You’ll feel the desk “snap” along that line. Then 
click to complete the ROTATE command. 

(Thanks to Sankay Kulkarni for this method.) 
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10. Move and copy objects with Drag ‘n’ Drop 

 

To perform a basic drag and drop, simply select an object with the left 
mouse button (with no commands running), then click and hold the 

left mouse button on the selected object. You’ll see a small rectangle 
at the cursor. Now you can drag the object around the drawing 
window. When you release the left mouse button, the object is placed 

at the cursor’s location.  

However, you can obtain additional options when performing a drag 
and drop move. Follow these steps: 

1. Select the object 

2. Click and hold the right mouse button until you see the 
rectangle at the cursor, then drag the object to a new location.  

3. Release the button; a menu displays.  

4. From this menu, choose one of the options to move the object 

to the new location, copy it to the new location, paste it as a 
block in the new location, or cancel the move.  

This provides you with an easy way to manipulate objects with just 

the mouse. 

11. Break objects quickly AutoLISP Routine 

People are always looking for a quicker way to break objects. Here’s a 

routine, SCISSORS, that has 3 features: 

 You don’t need to preselect the object; you just click the point 
where you want to break 

 Only if there are more than 1 object under the break point 

(that is, if you click on the intersection of objects), does the 
command ask you to select which object you want to break 

I tested it, and it worked fine for me. Thanks to Febien Mosen for this 

routine! 

You can download the AutoLISP file here. 

Here’s the code: 

http://www.ellenfinkelstein.com/autocadtips/images/scissors.zip
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(defun C:SCISSORS( / pt1 bpt1 bpt2 ss1 dist1 ent1 centrecercle) 
;;make it quiet 

(setvar “cmdecho” 0) 

;;first, get the breaking point 
(setq pt1 (getpoint “Give me the break point… “)) ;;point where to 

break 

;;now, check if there’s more than one object under that point 
(setq ss1 (selectfrompoint pt1)) 

;;if there’s more than 1 object under point, ask to select, else use 

existing point 
(if (> (sslength ss1) 1) 

(progn ;;then 
(princ “DISAMBIGUATION : pick the object to break…”) 
(setq ent1 (entsel)) 

(setq ent1n (car ent1)) ;; e-name of ent1 
(setq bpt1 (cadr ent1)) ;; point on ent to break 

) 
(progn ;;else 
(setq ent1n (ssname ss1 0));;store into an entity (can be useful 

further) 
(setq bpt1 pt1) ;; point on ent to break 

) 
) 

;;but if it’s a circle (thus usually unbreakable)… 

(if 
(= (cdr (assoc 0 (entget ent1n))) “CIRCLE”) 
;;then replace the circle by 2 arcs joining at the break point 

(progn 
(princ “It’s a circle !”) 

(setq centrecercle (cdr (assoc 10 (entget ent1n)))) 
(command “_arc” “_c” centrecercle pt1 “_a” “180″) 
(command “_arc” “_c” centrecercle pt1 “_a” “-180″) 

(entdel ent1n) 
) 

;;else perform a normal break 
(progn 
(command “_break” bpt1 “_f” pt1 pt1) 

) 
) 
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;;restore cmdecho 
(setvar “cmdecho” 1) 

;;end quietly 
(princ) 
) 

;;— this function makes a selection set of entities beneath a point 
(defun selectfrompoint (bpt1 / dist1 ss1) 
(setq dist1 (/ (getvar “viewsize”) 200)) ;; set a distance equal to 

1/200-th of view height 
(setq ss1 ;;select by fence around point 

(ssget “_F” 
(list 
(list (+ (car bpt1) dist1) (+ (cadr bpt1) dist1) 0) 

(list (- (car bpt1) dist1) (- (cadr bpt1) dist1) 0) 
) 

) 
);; setq ss1 
ss1 

) 

12. Trim objects quickly 

When you trim objects, the first prompt asks you for a cutting 
edge. You can press Enter to specify all objects as potential cutting 
edges. 

Then you just select the part of the object that you want to trim 
and AutoCAD automatically trims it at the closest possible cutting 
edge. 

So remember: 

1. Start the TRIM command 

2. At the Select cutting edges … Select objects or <select 
all>: prompt, press Enter. 

3. Select the object(s) to trim. 

There’s another shortcut for trimming objects—the EXTRIM command. 
EXTRIM lets you choose an object and then one side of the object. 
Here are the steps: 

1. Type extrim on the command line. 
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2. At the Pick a POLYLINE, LINE, CIRCLE, ARC, ELLIPSE, 
IMAGE or TEXT for cutting edge: prompt, select one of the 

listed objects. 

3. At the Specify the side to trim on: prompt, pick on one side of 
the selected object. 

13. Extend lines to make corners with chamfer 

The CHAMFER command makes mitered (angled) corners, like the one 
below. 

 
 

However, you can also use the CHAMFER command to extend lines to 
meet and make right-angled corners. In other words, you can use the 

command to turn the situation on the left to the situation on the right. 

 

 
 

 
You do this by setting the Distance and Angle options to zero. 

When you start the command, it lists the current settings: 
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Command: _chamfer 
(TRIM mode) Current chamfer Length = 1.0000, Angle = 45 

Select first line or 
[Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]: 

In this example the Distance option (which shows as Length) is 1 unit, 

and the angle is 45°. To create a square corner, use the Distance 
option and set both distances to 0. (You can specify a chamfer with 
two distances, rather than with a distance and an angle.) Then use 

the Angle option and set its value to 0. Then select both lines near 
their endpoints to get a square corner. 

But that’s a lot of setting! Instead, you can quickly and temporarily 

override any non-zero settings by selecting the first line, and then 
pressing Shift as you select the second line. Presto! Instant square 

corners. 

You could also use the EXTEND command (or the TRIM command with 
the Shift key), but the CHAMFER command is faster. 

14. Precisely scale an object when you know before and after 

dimensions 

Let’s say that you have a circle with a diameter of 35 and you want to 

scale it so that it has a diameter of 50. 

Here are the steps: 

1. Start the CAL command. 

2. Command: cal 

>> Expression: 50/35 
1.42857143 

3. Select the quotient 1.42857143 and copy it to the Clipboard. 

4. Start the SCALE command, select the object, specify the base 

point, and click on the Command line. (If you don’t click on the 
Command line, AutoCAD thinks that you want to paste a text 

object into your drawing.) 

5. Paste the quotient from the Clipboard and press Enter. 

Your circle now has a diameter of 50. (Thanks to Ken Monsanto of 
Bahrain Precast Concrete for these steps.) 
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Instead of the CAL command, you can use the newer QUICKCALC 
command and use the calculator-like interface. 

 
The advantage is that the command automatically copies the result to 
the Clipboard for you. 

If you’re scaling a circle, and you know the radius (or dividing by two 

is easy), here’s an easier method. This method works in AutoCAD 
2006 and later. Follow these steps: 

1. Select the circle. 

2. Click one of the quadrant handles and drag inward or outward. 

3. Type the new radius and press Enter. 

15. Match properties 

An object can have a lot of properties and sometimes you want one 

object to have the same properties as another object. Here are 3 tools 
that you can use to get the job done quickly. 

Use the MATCHPROP command 

The MATCHPROP command has been around a long time and lets you 
easily copy properties from one object to another. 
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Match a layer only 

If you want to match a layer and nothing else, you can use the 
LAYERMCH command, which is available in recent releases of 

AutoCAD and as an Express Tool in earlier releases. Follow the 
prompts carefully, because it works differently from MATCHPROP.  

Create a new object that is like an existing object 

A new command for AutoCAD 2011 is the ADDSELECTED command, 
which creates a new object with the same properties as an existing 
one.  

Watch videos on my website to see how these options work. 

http://www.ellenfinkelstein.com/acadblog/match-properties/
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Chapter 5: Adding Text and Dimensions Easily 

16. The many ways to import text 

There are several ways to bring text from other documents into your 
drawing. 

1. The Multiline Text Editor: Save the text as a text (.txt) or 

Rich Text Format (.rtf) file. (You do that in your word 
processor by choosing File>Save As and choosing one of those 
formats from the Save as Type drop down box. Rich Text Format 

keeps a good deal of the text formatting.) Choose Multiline Text 
from the Draw toolbar to open the Multiline Text Editor. With the 

Character tab on top, click Import Text and find your file in the 
Open dialog box. Click Open. You can now format the text using 
the Multiline Text Editor’s tools, a nice advantage. If the file is 

over 16K, copy the text to the clipboard from the other file and 
return to AutoCAD. In the Multiline Text Editor, right click and 

choose Paste.  

Instead of creating a .txt or .rft file, you can copy to the 
clipboard and use the Paste Special option in AutoCAD (Home 

tab, Clipboard panel, Paste drop-down). In the dialog box that 
appears, choose TEXT; the information from the clipboard is 
inserted as MTEXT, and is now fully editable. (It will come into 

AutoCAD as a single row of text; drag the right arrow or margin 
to wrap the text, if desired.) 

2. Drag-and-Drop: If you have a text or RTF file that you want to 

import, you can simply drag it in from Windows Explorer. Open 
Explorer and locate the file. Position/size the Explorer window so 

you can also see your drawing. Click the file and drag it into 
your drawing, then release the mouse button. If you later wish 
to format it differently, choose Modify>Text, select the text and 

format it in the Multiline Text Editor which opens. 

3. Copy and Paste: Let’s say you want to import part of a file, 
even just a few words. You can open the file, select the text, 

copy it to the clipboard, and then return to AutoCAD. Now paste 
– Ctrl + V is fine. (AutoCAD may open the OLE properties dialog 

box, where you can specify size, scale, plot quality and so on. 
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Click OK.) AutoCAD pastes in the text with the original 
formatting intact. This is an embedded object. You can’t edit this 

in the Multiline Text Editor, but you might not need to. 

4. Insert Object: Choose Insert>Object. (This is the same as the 
INSERTOBJ command.) Choose Create From File. Click Browse, 

find the file and click Insert. You can now choose Link to link the 
data in your drawing to the original file, if you want it to be 
updated each time you open or plot your drawing. Click OK. This 

method also creates an embedded object. 

17. Secret MTEXT options: Remove formatting, combine 

paragraphs, change case 

The Mtext Editor has three options that many people miss. In the 
Mtext window, select the text you’ve entered and right- click inside 

the text area. Choose one of the options: 

 Change Case to change the text to all uppercase or all 
lowercase. 

 Choose Remove Formatting to return all text to Txt font and 
remove bold, italic and other formatting. 

 Choose Combine Paragraphs to do just that. 

18. Use fields for titleblock text 

If you insert titleblock text for your drawings, you know that keeping 
that text updated and accurate can be a chore. Also, many people 

place drawing numbers and names in more than one place in a 
drawing, requiring extra work. 

You can use fields to automate the insertion of titleblock text – or any 

other annotation in a drawing. Especially if you use the text over and 
over again, you can save time and improve accuracy. Examples are 
the current date, the drafter’s initials, the company name and 

address, and so on. 

In this tutorial, I assume that you’re using MText for your titleblock 
text, but you can use the same technique with block attribute text. 

Follow these steps: 
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1. You use the Drawing Properties feature to create custom 
properties. Choose the Application button> Drawing Utilities> 

Drawing Properties to open the Drawing Properties dialog box. 

2. Click the Summary tab. If you can use any of these properties, 
start here. For example, you can use the Title field for the 

drawing name. 

3. To add a custom field, c lick the Custom tab. Use a custom field 
for content that cannot use one of the fields that come with 

AutoCAD. 

4. Click the Add button. In the Add Custom Property dialog box, 
enter a field name and value and click OK. 

 
1. Repeat Step 4 for all of your custom fields. 

2. Click OK to close the Drawing Properties dialog box. 

3. To insert fields, start the MTEXT command and define the 
bounding box (or use the ATTDEF command to create an 
attribute definition). 
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4. In the Text Editor (or Value or Default text box of the Attribute 
Definition dialog box), right-click and choose Insert>Field. You 

can do the same in a table. 

5. To find your custom fields most easily, choose Document from 
the Field Categories drop-down list. You’ll see all your custom 

fields listed. 

6. Choose the field you want, choose a format, and click OK. 

7. Repeat Steps 7-10 for all your custom fields. 

8. To use any of the fields that come with AutoCAD, again choose 
Insert>Field, choose a different category, field, and format. 

Note: The CreateDate field creates an unchanging date field, based 
on today’s date. The Date field creates a date field that always 
changes to display today’s date. 

 
The gray background tells you it’s a field; the background doesn’t 

print. 

You can save your custom fields in a template and have them 
available for any drawings based on that template. 

AutoCAD comes with some very interesting and useful fields. Browse 

through the list to see if some might be useful for you. For example, 
choose Insert>Field, choose the Objects field category, choose the 
Object field, and click the Select Object button to select an object in 

your drawing. Now you’ll see a list of properties that you can choose 
from. You can use this to create labels that display properties about 

your objects, such as the area of a circle or the coordinates (position) 
of any object. 
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19. Override a dimension 

It’s always good to stick to your dimension styles as much as 

possible, but sometimes a situation requires an exception. You can 
create an override, which is a sub-dimension style that varies from its 
parent style. 

Follow these steps: 

1. On the Annotate tab, click the Dimensions panel’s dialog box 
launcher arrow (the arrow at the right end of the panel’s title 
bar). 

2. In the Dimension Style Manager, choose the style that you want 
to override and click Override. 

3. The Override Current Style dialog box opens. This is just like the 

New Dimension Style dialog box and you make your changes in 
the same way you would to create a new dimension style. 

4. When you’re done, click OK. The override appears in the Styles 

pane of the Dimension Style Manager beneath its parent style. 

 
 

5. Click Close. Dimensions that you create now use the override 
settings. 

This override suppresses the left extension line. 
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To stop using the override, again open the Dimension Style Manager 

and choose the parent style as current. However, this discards the 
override. 

To stop using the override, but save it for later, right-click the 

override in the Styles panel of the Dimension Style Manager and 
choose one of the following: 

 Rename: Creates a new dimension style from the override. 

Type a new name and press Enter. 

 Delete: This is the same as choosing the parent style and 
setting it current 

 Save to Current Style: Changes the parent dimension to 

include the override settings 

20. Print a list of text styles 

You might also want to print out a list of your text styles.  

1. At the command line, type -style. 

2. At the Enter name of text style or [?] 
<STANDARD>: prompt, type ? (a question mark) and press 

Enter. 
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3. At the Enter text style(s) to list <*>: prompt, press Enter. 
The AutoCAD Text window opens with a list of your text styles 

and their properties. 

4. Select the entire list and copy it to the clipboard. (Ctrl+C). 

5. Open any word processor or text editor and paste the list into a 
new document (Ctrl+V). 

6. Print the list. 

21. Print a list of dimension styles 

A list of dimension styles is also helpful. You can create a simple list 

You can list the settings of any individual style, though. But you can 
do even better; you can list compare the settings of two dimension 
styles. Comparing dimension styles is great for troubleshooting 

dimensions. 

To create a simple list of dimension styles, follow these steps: 

1. At the command line, type -dimstyle. 

2. At the prompt, type ? (a question mark). 

3. At the Enter dimension style(s) to list <*>:prompt, press 

Enter. The AutoCAD Text window opens with a list of your 
dimension styles. 

4. Select the list and copy it to the clipboard. (Ctrl+C). 

5. Open any word processor or text editor and paste the list into a 
new document (Ctrl+V). 

6. Print the list. 

To list the settings of any individual dimension style, here’s the 

procedure: 

1. Type -dimstyle on the command line. 

2. At the prompt, type v to start the Variables option. 

3. At the Enter a dimension style name, [?] or <select 

dimension>: prompt, type the name of the dimension. (If you 
don’t know the name, type ? to get a list first. If you want the 
current dimension style, you can use the STatus option.) 
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The AutoCAD Text window opens with a list of all the system 
variable settings for the dimension style you chose. 

4. This is a LONG list. To select the list, scroll up to its beginning 

and click the mouse there to place the insertion point. Scroll to 
the bottom of the list. Press Shift and click at the end. The 

entire list should now be highlighted. Copy it to the clipboard. 
(Ctrl+C). 

5. Open any word processor or text editor and paste the list into a 

new document (Ctrl+V). 

6. Print the list. 

To compare the settings of two dimension styles: 

1. From the menu, choose Dimension>Style. 

2. Click Compare. 

3. In the Compare Dimension Styles dialog box, choose the two 

dimension styles in the Compare and With drop-down lists. 

4. The list is displayed in the dialog box. It shows only the 
differences between the two dimensions, not all the settings. 

5. Now here’s the secret. At the upper-right corner of the list is a 

button that looks like the Copy to Clipboard button on the 
Standard toolbar: Click this button to copy the list to the 

Windows clipboard. 

6. Open any word processor or text editor and paste the list into a 
new document (Ctrl+V). 

7. Print the list. (In Microsoft Word, choose Insert> Table (drop-

down arrow)>Convert Text to Table to create a nice table.) 
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Chapter 6: Streamlining Work with Named Components 

22. Save and use layer states to streamline your work 

Layer states let you save configurations of layer properties and states. 

For example, you might want a layer to be red sometimes, and blue 
at other times. You may need certain layers to be locked, off, or 

frozen when you’re editing one part of the drawing, but unlocked, on, 
or thawed when you’re editing another part. 

You could spend lots of time adjusting layer properties, but instead, 

you can use layer states — they’re much easier and quicker. 

Create and restore a layer state 

Follow these steps to create a layer state: 

1. Set all of the layer states and properties the way you want 
them. A good idea is to first save the default, “normal” situation 

before saving variations. 

2. To open the Layer States Manager dialog box, open the Layer 
Properties Manager and click the Layer States Manager button. 
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3. Click New and type a name and description for the layer state. 
Click OK. 

4. Click the More Restore Options button  to expand the dialog 

box. (In earlier releases, the options are at the bottom of the 
dialog box.) 

 
 

5. Uncheck any states or properties that you don’t want to save. 

For example, if you don’t save the Color property, the color 
won’t be affected when you restore the layer state. Therefore, if 
you change a layer’s color and restore the layer state, the layer 

will remain the new color. 

6. If you want your drawing to exactly match the way it looks now, 
check the Turn Off Layers Not Found in Layer State check box in 

the main section of the dialog box. When you check this box, 
any new layers that you create afterwards are turned off when 

you restore the layer state. 

7. Click Close to save the layer state. 

You can continue to display desired states and save them until you 
have all the layer states that you need. 
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To restore a layer state, open the Layer States Manager, choose the 
layer state and click Restore. 

Share layer states 

Layer states are saved in the drawing. To share them among 
drawings, you need to export them. Each layer state has its own LAS 
file. To export a layer state, select it in the Layer States Manager, and 

choose Export. In the Export Layer State dialog box, enter a name, 
choose a location, and click Save. 

To import a saved layer state, open the Layer States Manager, and 

click the Import button. In the Import Layer State dialog box, choose 
Layer States (*.las) from the Files of Type drop-down list. Choose the 

LAS file that you want, and click Open. 

You can save layer states in your templates for maximum ease and to 
maintain CAD standards. Layer states can be an important method for 

controlling how your drawings look and speeding up the drawing and 
editing process. 

23. Name objects so they’re easy to find 

 

When you share drawings with others, you’ll end up with dimensions,  

text styles and more that you didn’t create. You can have your own 
creations, such as dimension or text style, layers, and blocks, easily 
accessible. Just start their name with the underscore _ character and 

they will always be at the beginning of the lists (Thanks to Franck 
Wallez for this tip.) 

24. Find all named objects in a drawing 

For troubleshooting or collaborative purposes, you may need to know 
the named objects in your drawings, that is: 

 Blocks 

 Dimension styles 

 Layers 

 Linetypes 

 Materials 
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 Table styles 

 Text styles 

 UCSs 

 Viewports (really viewport configurations) 

 Views 

 Plot styles (which you see only if you’re using named plot 
styles) 

You can see all your named objects by using the RENAME command. 

In the Rename dialog box, choose the type of named object you want, 
and you’ll see all of its items. 

 
 

Of course, you can also use this command to rename objects; it’s 
very handy for that purpose. 

Unfortunately, while you can select all of the named objects for a 

category, you can’t copy them to the Clipboard.  
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Chapter 7: Opening Drawings and Creating Professional 
Output 

25. Save layouts with layout templates 

When you create a layout, including viewports, a title block, text, and 
so on, you can save it as a template to use in the future. If you would 

sometimes like to use a layout from a different drawing, one that isn’t 
included in your drawing’s template, and therefore not available to 
you in your drawing, then the LAYOUT command is ideal. 

You can specially save a layout as a template, or you can use a layout 
from any existing drawing or template. What’s special about using 
templates in this way is that you get only the layout and its objects, 

layers, and settings; you don’t import any model space objects, block 
definitions, layers, and so on. So it’s a clean way to use existing 

layout in your current drawing and you don’t need to purge unwanted 
definitions. 

Save a layout template 

First, name the layout tab, because a name of Layout1 won’t be very 

helpful. 

When you create a unique layout that you might want to use at 
another time, enter layout on the command line. At the prompt, use 

the SAveas option, and enter the name of the layout. 

Enter layout option 
[Copy/Delete/New/Template/Rename/SAveas/Set/?] <set>: sa 

Enter layout to save to template <3-detail>: 

The Create Drawing File opens, with the Template folder automatically 
selected and the template file type specified. Enter a name for the 

template, perhaps the same as the name of the layout, and click 
Save. 

Use a template layout 

To use a template layout, right-click a layout tab, and choose From 

Template. 
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In the Select Template from File dialog box, choose the template that 
you want and click Open. 

In the Insert Layout(s) dialog box that opens, choose the layout that 

you want, and click OK. AutoCAD creates a new tab with the same 
name, settings, and objects as the source layout. 

 
Note: You can choose any drawing file, not only a template. 

Note: If the viewport layers are frozen in the template or other 
drawing, they’ll come in to your drawing frozen. 

26. Switch among open AutoCAD drawings 

You may have several drawings open at one time and want to switch 

between/among them. AutoCAD gives you several methods to do so. I 
can think of four. 



Top 25  AutoCAD Productivity Tips  

Every AutoCAD User Should Know: Drawing and Editing 

 

47 

Use the Windows taskbar 

The Windows taskbar can show a separate button for each drawing. 
The system variable for this is, appropriately enough, TASKBAR. 

When set to 1, you’ll see a separate button for each drawing. Then 
you can easily click the drawing you want to display it. In Windows 7, 

the default value for TASKBAR is 1. However, in earlier versions of 
Windows, the default is 0, so you need to change the value if you 
want separate buttons. Just type taskbar, press Enter, type 1, and 

press Enter again. 

Press Ctrl + Tab 

Just press Ctrl + Tab to cycle among your drawings. Thanks to Franck 

Wallez for this tip. 

Use Quick View on the status bar 

Click the Quick View Drawings button on the right side of the status 
bar. You’ll see a display like this. 

 

Click the thumbnail of the drawing you want to display. 

Application button list of open drawings 

Click the Application button at the upper-left corner of your screen. By 
default, you see a list of recent drawings. Click the Open Documents 

icon to see a list of open drawings and choose the one you want to 
display. 
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Bonus Tips 

 

Bonus A: Use the Shift key as a shortcut 
You can use the Shift key in AutoCAD in many ways to help make 
your AutoCAD tasks easier and quicker: 

 Shift + right mouse button to display the OSNAP menu. 

(Thanks to Tommyy Holden, Kent Elrod, Edwin Prakoso, Jon 
Groelz, W.S.Walker, Hans Graveman, and Kevin Schaefer.) 

 Shift + middle mouse button (usually the scroll wheel) to 

transparently go into 3D orbit. (Thanks to Kent Elrod, Edwin 
Prakoso, W.S.Walker, and Susan Lafleur.) 

 Shift + click multiple grips to select them. (Thanks to Kent 

Elrod, Rusty Gesner, and Gary Ketter.)  

 Ctrl+Shift+C: This is the COPYBASE command. It copies a 
selected object, prompting you for the base point. 

 Ctrl+Shift+V: This is the PASTEBLOCK command. It pastes an 

object that you copied to the clipboard as a block. AutoCAD 
assigns it a name. (Thanks to Bill Northrup for both COPYBASE 

and PASTEBLOCK.) 

 You can set AutoCAD (on the Drafting tab of the Options dialog 
box) to require pressing the Shift key to acquire a point for 

tracking; it’s not the default setting, though. As a matter of 
fact, you can set AutoCAD (on the Selection tab of the Options 
dialog box) to require pressing the Shift key to select more 

than one object at a time (the way you do in most other 
programs). 

 Press Shift with the FILLET or CHAMFER command to change 

the radius to 0 and extend to lines to meet 

 Press and hold Shift to temporarily override ORTHO. 

 Press and hold Shift+A to temporarily override OSNAP. 

 Press Shift to change TRIM to EXTEND and vice versa. 
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 Press Shift and pick objects to remove them from the current 
selection set. You can also press Shift and click a window or 

crossing selection. (Thanks to Tommy Holden for this one.) 

 If you have several objects that overlap at a point, mouse over 
that point, press Shift and press the Spacebar repeatedly to 

cycle through these objects 

 
 

 In the AutoCAD Text window (press F2 to open and close it), 

press SHIFT with a key to highlight text. For example, press 
Shift + Home to highlight text from the cursor to the beginning 
of the line. Or press Shift + the Up arrow to select the previous 

line of prompts. 

Here are all the keyboard shortcuts I could find in AutoCAD’s Help 
that use Shift: 

 SHIFT+, Object Snap Override: Center 

 SHIFT+. Toggles Polar Tracking 

 SHIFT+/ Toggles UCSDETECT 

 SHIFT+; Enables Object Snap Enforcement 

 SHIFT+] Toggles Object Snap Tracking 

 SHIFT+C Object Snap Override: Center 

 SHIFT+D Disable All Snapping and Tracking 

 SHIFT+E Object Snap Override: Endpoint 

 SHIFT+L Disable All Snapping and Tracking 

 SHIFT+M Object Snap Override: Midpoint 

 SHIFT+P Object Snap Override: Endpoint 
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 SHIFT+Q Toggles Object Snap Tracking 

 SHIFT+S Enables Object Snap Enforcement 

 SHIFT+V Object Snap Override: Midpoint 

 SHIFT+X Toggles Polar Tracking 

 SHIFT+Z Toggles UCSDETECT 

 

Bonus B: Spacebar Shortcuts 
As an equivalent to the Return/Enter key 

With one exception, you can use the Spacebar instead of the Enter 

key. It’s often more convenient, because it’s bigger and if your right 
hand is on the mouse, you can hit the Spacebar with your left hand. 

Similarly, you can press the Spacebar at the Command prompt to 
repeat a command you just used. 

The exception is when you’re using a text command, such as MTEXT 

or TEXT. Pressing the Spacebar, of course, just inserts a space in the 
text. To end the MTEXT command, you can’t press the Enter key 
either, because that just inserts a new line in the text. Instead, just 

click outside the text area or click the Close Text Editor button on the 
ribbon. 

To cycle among Grip editing options 

(Thanks to Hein Veeman, a “Technical Draftsman and AutoCAD 
shortcut freak” in the Netherlands for this tip.)  

1. Select an object by clicking on it with your mouse. 

2. Select a grip point of that object. You will see the following in 

the command line: ** STRETCH ** Specify stretch point or 
[Base point/Copy/Undo/eXit]: 

3. Press the Spacebar once more to cycle to the MOVE option. 

4. Continue to press the Spacebar to get the Rotate, Scale, and 

Mirror options. 



Top 25  AutoCAD Productivity Tips  

Every AutoCAD User Should Know: Drawing and Editing 

 

52 

Select overlapping objects with object cycling 

If you have several objects that overlap, you may find it hard to 
select the one you want. This used to be a real annoyance, because 

you would select the wrong object, deselect it (by pressing Esc), and 
try again. In recent releases, AutoCAD highlights objects when you 

just hover over them, which makes selecting the right object much 
easier. 

Nevertheless, if you’re using an earlier release or have the hover 

highlighting effect turned off, object cycling can help. (By the way, to 
customize hover highlighting, start the OPTIONS command. On the 
Selection tab, click the Visual Effect Settings button. In the Selection 

Preview Effect section, you can change the settings.) 

To use object cycling, at the Select objects: prompt, place the cursor 
over the area where objects overlap. Then hold down the Shift key 

and press the Spacebar. One object is highlighted. If it is not the one 
you want, with the Shift key still down, press the Spacebar again. 

AutoCAD cycles through the objects. When the object that you want is 
highlighted, pick the object. 

Cycle through faces of a solid 

If you want to select the back face of a solid, you can cycle through 

the faces by pressing and holding Ctrl and repeatedly pressing the 
Spacebar. Remember that pressing the Ctrl key selects subobjects, 

such as the face of a solid. 

Cycle among 3D gizmos 

Use the Spacebar to cycle among the three 3D gizmos, Move, Rotate, 
and Scale. The gizmos help you move, rotate, and scale 3D models.  

You can select an object and the current gizmo appears on the object 

or you can choose the gizmo you want from the ribbon. You then 
constrain the direction of the move, rotate or scale operation by 

clicking one of the colored elements (which correlate to the X, Y, and 
Z axes.)  Once you constrain the move, you can press the Spacebar 
to cycle among the three gizmos, without losing the directional 

constraint you specified. 
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Bonus C: Use the command line to launch programs 

You can start certain Windows programs from the AutoCAD command 

line. These programs are in the acad.pgp file that defines aliases for 
commands. The first section has aliases for Windows commands. 

To edit this file and add more commands, choose Manage> 

Customization> Edit Aliases. Notepad opens the acad.pgp file. Scroll 
down until you see the following: 

 

Therefore, if you type explorer on the command line, Windows 

Explorer opens. To open a new file in Notepad, type notepad and 
press Enter at the prompt that appears. 

If you add commands, use the same format. The text before these 

commands explains the meaning of the 1 and the general format. 
Then save the file. Back in AutoCAD, you may need to type reinit to 
reinitialize acad.pgp so you can use your changes. 

You can type start on the command line and it functions like choosing 

Start> Run in Windows. For example, you can 
type winword or excel to open those programs (if you have them 

installed). Or type calc to open the Windows calculator 
or mplayer2 for the Windows media player. (Thanks to Tushar 

Dabholkar from Pune, India for this tip.) 
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Learn more! 

Don’t miss out! Click here to sign up for the AutoCAD Tips Newsletter 
and you’ll know when new tips come out. 

  

http://www.ellenfinkelstein.com/acad_submit.html
http://www.ellenfinkelstein.com/acad_submit.html
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